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Registration

What do I Register? 
Why Register? 
How do I Register? 
Enter your Registration Code(s) 

What do I Register?
New with version 1.3 is the ability to register the main program and/or MP3 support.    
We wanted to offer good MP3 support, but did not want to have to raise the price of the 
main program, so we offer MP3 support as an optional upgrade.    (The MP3 decoding 
engine belongs to MPEGTV, LLC.)

Why Register?
Registering will entitle you to the following benefits.

q Unlimited technical support
q Free upgrades for all 1.x version; i.e.: v 1.0 -> v 1.99
q IMIX is fully functional
q Priority feature requests.    If there is something that you want IMIX to do, just 

request it and it will most likely end up in a future release.    We will take your 
input very seriously!

q Extension of integrated MP3 support beyond 30 days.

In addition, you will be supporting Acoustica and its mission to create high quality and 
intuitive software. 

OK, So you want to register.    How do you register? 
You can obtain your registration code(s) via the following ways…

q Internet Registration
Launch your web browser and browse to 
http://www.acoustica.com/register.html All necessary instructions are on the 
web site.

q Old Style Mail Registration (Snail Mail)
Fill out register.doc in the Internet Audio Mix program group, print it out and 
send it to:

Acoustica
P.O. Box 728



Oakhurst, CA 93644
U.S.A.

Upon payment, a registration code will be emailed or mailed to you. 

You have your registration code now!    How do you enter your registration code 
into Internet Audio Mix?

You will simply need to run Internet Audio Mix.    The first screen should prompt you 
for a registration code.    Additionally, you may select “Register” from the “Help” 
menu.    Enter the code you obtained and press the Register button. 

If you are registering the MP3 support only, select “Register MP3 Support” from the 
“Help” menu.    Enter your MP3 Support registration code and hit the Register button.

Now you are registered Internet Audio Mix owner!    Thank you very much! 
If you have any problems please email support@acoustica.com 

-The Acoustica Team



Quick Start
So you want to get started in a hurry?    Follow “SoundWarrior” through the steps to 
Internet Audio Mix mastery!

1. Start Internet Audio Mix
SoundWarrior double clicks the Internet Audio Mix icon on his desktop.    Okay, we 
could have left this step out. J

2.    Drag in some sounds.
SoundWarrior has a good sound of a cave-woman scream called arghhh1.wav.    
The sound is located in “c:\cavescreams\”, which he finds, and then drags the 
sound’s icon onto the Internet Audio Mix window.    See working with sounds. 

3.    Drag in some more sounds.
SoundWarrior also drags in stampede.wav, the sound of a herd of Mastodons 
stampeding by his cave.    Finally, he drags in an MP3 called “rockrolls.mp3”, 
some of the latest music from “The Stoners”

4.    Make a recording if you want.
SoundWarrior hits the record button and the record dialog comes up.    He punches 
the record button on the dialog and screams into his microphone “You make fire 
now!    I make fire yesterday!”    He then hits the stop button, previews the sound 
and saves it as “me_talk1.wav”.    See recording sounds. 

5. Save
SoundWarrior hits ctrl-S and a dialog box asks him to name the Sound Group.    
He calls it cavesound1.sgp.

5. Export As RealAudio™
He wants to put it on cavenet.com so others can be jealous of his work of art.    He 
presses the RealAudio™ button on the toolbar, which brings a dialog.    He finds 
the best RealAudio format for the job.    In this case, he selects “16 Kbps Music – 
Medium Response” and hits the preview button.    A RealAudio dialog comes up 
and plays 5 seconds in the RealAudio format.    He likes it and then hits the save 
button.    He names it soundwar.ra and hits the save button on the Save As dialog. 

7. Find a Mastodon to chase? J
With all the time he saved, he can take the rest of the day off.    Maybe he’ll draw 
some paintings or even sharpen a stick. 





Overview
Internet Audio Mix is an intuitive multi-track sound recording and mixing utility. 

 Let your creativity take off…….!
It lets you record, overdub and mix multiple tracks of .wav and .mp3 files.    The 

simple, fast and intuitive interface makes it a no-brainer when it comes to 
sound mixing.    With support for the standard copy, cut, paste, undo and redo you 
can even make a few mistakes! 

Drag sounds in , record a few from the CD or microphone.    Change things in 
real-time while its playing.    Focus on your creativity, not technical details! 

Internet Audio Mix lets you edit 3 primary effects non-destructively!    It gives you the 
ability to edit and create   “  pivot points  ”   for volume, pan, and playback rate.    For 
example, if you wanted to fade in a “coolness.wav”, you could create a volume pivot 
point, set it to 0% volume, create another pivot point further down on the sound and 
drag it to 100% volume.    You can add as many pivot points as you want.    If that’s 
not enough, you can also edit the sound or a copy of a sound in an external sound 
editor.

If you start to have a lot of sounds or a lot of tracks, you can make a Sound Group.  
For example, you could group all of your “laughing” sounds into a single “laughing” 
Sound Group or “laugh track”.    You can then drag that Sound Group around as if it 
was a single sound.    You can even shape the volume and pan for the entire group 
with its own non-destructive pivot points.    This can be extremely useful and time 
saving!    At later dates, you can even import other Sound Group Files (.sgp) into your 
session!

Once you have everything the way you like it, you can save it as a Wave or 
RealAudio file .    It lets you quickly preview the session in different RealAudio 
compression algorithms to find the one that works best.    You can even preview how it 
will sound 5 minutes into the session.    (Normally, this would require you to render the 
entire thing, which can be quite time consuming.)

New to Internet Audio Mix 1.32
q Better zoom in/out
q Bug fixes

New to Internet Audio Mix 1.3
q Support for RealNetwork’s G2 protocol, including Surestream.
q Integrated MP3 support.



q Bug fixes

New to Internet Audio Mix 1.25
q Improved recording level display
q Better support for MP3.
q Lock/Unlock positions for sounds and Sound Groups.
q Undo/Redo support for locking, muting, and changing of names.
q Bug fixes

New to Internet Audio Mix 1.21
q Recording from the hard drive or RAM.
q Playback selections.
q Double click and add a sound at that time offset.
q Option to combine playback indicator and paste point (caret).
q Cancel button during wave file/RealAudio rendering.
q Bug fixes.

New to Internet Audio Mix 1.2
q Full duplex recording (overdubbing)
q Edit waveforms in an external sound editor.
q Copy, cut and paste portions of sounds or sound groups.    For example, this is 

very useful and fast if you want to only copy the word “cool” from a long 
passage.

q Render the whole session or just what sounds or Sound Groups you’ve 
selected as RealAudio clip.  This is handy for listening to a portion of your mix 
in RealAudio.

q Support for importing and mixing .mp3's if you have a MPEG Layer-3 codec for 
Window's Audio Compression Manager installed.    See website for more 
information on installing a MP3 codec.

q Supports multiple sound cards.    Select the sound card for playback and the 
one for recording



Troubleshooting

Its not making any sound 
Sound is breaking up 
How do I record from the CD? 
I can  ’  t preview RealAudio™ files   
Internet Audio Mix won't load the sound. It says that the format is unsupported 
I edited a sound in an editor and it messed up other sounds! 
How do I set IMIX up to record from memory (RAM)? 
I  ’  m not hearing real-time changes of effects during playback!   
I can  ’  t render to RealAudio.    It says I need to download more files!   
How do I overdub or record while listening to my other tracks? 
New Tracks are picking up sound from old tracks 
It takes too long to load MP3s! 
Recording is not working! 
Hey, I can  ’  t even find my problem in this section!   

It’s not making any sound
You’ve added sounds, but you can’t play anything...  There are a few things you can 
check here.

1. Are the speakers on and plugged in?  (Sorry, management made us ask.)
2. Can you play a Wave file through Windows sndrec32.exe or other sound 

application?   If you can't there may be a problem with your sound card's 
configuration or drivers.  Refer to your soundcard documentation to try to figure out 
what is wrong.

3. Load the volume control that came with your soundcard and make sure that the 
Wave device is turned up.

4. Another program may be using the Wave device.  Internet Audio Mix will put up a 
dialog stating that another application has the Wave device in this case.

Sound is breaking up
When playing the session, it sounds like someone is starting and stopping the sound 
real quick, repeatedly. This could be because the computer has slowed down due to 
other programs running at the same time. 

Internet Audio Mix has to work harder as the layers of sound increase. Try increasing 
the buffer size or the number of buffers in the Advanced Section of the Preferences 
Playback tab.



If you are doing a lot of recording and you find that the actual recordings are being 
broken up, you may change the Recording Settings on the Recording tab of the 
Preference Dialog.

I can’t preview or play RealAudio™ files
In order to hear RealAudio files, you must have the RealAudio player.    Download the 
latest player from http://www.realnetworks.com

Internet Audio Mix won’t load the sound. It says that the format is unsupported
There are many different types of sound file formats.    Internet Audio Mix currently 
supports the Wave (.wav) format.    Trying to load a .aif or .au will not work. 
In addition, Internet Audio Mix will work with Window’s Audio Compression Manager 
(ACM) to load compressed wave files. 

I edited a sound in an editor and it messed up other sounds!
If you had copied a sound and then edited it in an external editor in the “Edit Original” 
mode, it would have made the copies reference the same sound file.    If the length 
was changed or if the sound were altered in a time specific way, Internet Audio Mix 
would not have been able to load it back in the correct way.    Next time consider 
selecting the “Edit A Copy” option.

How do I record from the CD?
Internet Audio Mix supports the recording of whatever sound that it is possible to 
record via your soundcard.  Here are the steps to record your CD.
Recording from the CD is simple as long as your soundcard is connected to your CD. 
1) Click on the speaker icon on the lower right hand corner of the window's desktop. If 
you do not have this, then you may need to add/remove programs and make sure you 
select all "multimedia" components.
         This should have brought up a window that is titled "Volume Control".
2) Select "Properties" from the "Option" menu.
         This brings up another window
3) Select the "Recording" option from the "Adjust Volume For" grouping.
         Look at the list box called "Show the volume controls."
4) Make sure that the "CD Audio" option is selected.
5) Hit OK
          Brings up the "Recording Control" window.
6) Make sure that "CD Audio" option is selected and at a decent level. 
7) Put in an audio CD and start it playing.
8) Launch Internet Audio Mix
9) Select the Record option and make sure the "Show Recording Level" is selected.
          You should see the level indicator moving in IMix's recording level.



          Go back to the Recording Control window if it’s distorting.
10) Hit the record button in the IMIX Record window and you are done.

 How do I set IMIX up to record from memory (RAM)?
Go to the preference dialog and remove all text in the edit box labeled “Temporary 
Recording Directory”.    You should see the words “(RAM)” appear.    Then click “OK” 
and record to your hearts content. 

I’m not hearing real-time changes of effects during playback!
If you have some sounds selected, you will not hear your volume, pan, rate or 
clipboard changes during playback.      However, if you restart playback after making a 
change, you will hear the changes. 

How do I overdub or record while listening to my other tracks?
You need to make sure that you have done the full duplex test and have the 
“Overdub” checkbox checked on the recording dialog.    Depending on your 
soundcard’s level of full-duplex support, you may need to set the recording sampling 
rate to be the same as the playback sampling rate.

I can’t render to RealAudio.    It says I need to download more files!
Not everyone uses Internet Audio Mix to create RealAudio files.    We chose to leave 
out the RealAudio files and make it an optional download.    This makes the download 
much smaller.    If you see a window that says that you are missing these files, you 
have two options.    You can either download and run the patch from Acoustica or 
download/install a RealNetwork’s encoding program such as RealProducer™ or 
RealSlideshow™.    After installing one of these programs, your computer will be 
setup to render to RealAudio.

It takes too long to load MP3s!
For some longer MP3 files, especially on slower machines, it may take awhile to load. 
This is because Internet Audio Mix has to parse the entire file and decode it to get its 
graphical waveform.    If you don’t care about seeing the waveform on the sound bar, 
you can disable this and loading mp3’s will become almost instantaneous.    You will 
need to go to the “Miscellaneous” tab on the Preferences dialog.    Check the option 
“Don’t load waveforms for sounds >”.    Then enter in the maximum time length in 
seconds that you want waveforms for.    For example, if you don’t want any sounds 
that are over 10 seconds in length to have visible waveforms, enter “10”.

New tracks are picking up sound from old tracks.
Your new audio tracks are picking up remnants of other tracks.    Your microphone or 
input device is picking up the output from your speakers.    Try using headphones.    If 
that doesn’t work, your soundcard may have some touchy circuitry.    Go to your 
mixer’s recording settings and make sure that only the devices you are interested in 
recording are set.



 Recording is not working!
You’re mixing sounds great, but you can’t record anything!!!    There can be many 
reasons why this is not working.

1. Your microphone is not plugged in to the right hole in the back of your soundcard. 
Sometimes it happens. J

2. You’re trying to record on your CD but nothing is happening.    Make sure that your 
soundcard has a connection to your CD player.    This is usually an internal cable.

3. Another problem for not recording is related to the Win95/98/NT audio mixer.
q Double click the speaker icon on the lower right of your Window’s taskbar.
q Select “Properties” from the Options menu.
q Select “Adjust volume for recording” radio button.
q Make sure all the checkboxes are checked in the window entitled “Show the 

following volume controls” and press the “OK” button
q Make sure that the device you are trying to record is selected and the slider 

is up.
q For example, if you are trying to record the CD,    make sure the checkbox 

enabled “Select” in the “CD Audio” panel is checked, then adjust the slider 
to about 75%.

q Make sure that the overall “Recording” balance on the very left is also set at 
50%. (On many systems, you cannot adjust this anyhow.)

q Go back to Internet Audio Mix and start recording!

Hey, I can’t even find my problem in this section!
Start your Internet browser and go to http://www.acoustica.com for the latest help.    If 
it’s not on the website, you should send an email to us so that we can address your 
problem and help you out!



Working with sounds

Internet Audio Mix can load Window’s Wave (.wav) files and MPEG 1 Layer III (.mp3) 
files. 

Adding Sounds 
Recording Sounds 
Editing Sounds in an external sound editor 
Playing and stopping sounds 
Positioning and resizing/looping sounds 
Changing the sound  ’  s volume, pan and playback speed   
Sound Information Dialog 
Compressed Sounds (ADPCM, .MP3, etc.) 

Adding sounds 
Internet Audio Mix makes it very easy to add sounds.    You can drag the Wave or MP3 
file(s) from the desktop into the main Internet Audio Mix window.    There is no limit to 
the number of Wave files that you can drag into Internet Audio Mix at the same time.

Fig1a. Shows user dragging several Wave files into Internet Audio Mix from the Desktop.

You may also add sounds by going to the Sound Group menu and clicking “Add 
Sound…”.    This brings up a standard file dialog in which you can locate a sound, 
which you wish to add.    Select the Wave or MP3 file and click “Add”.    The sound will 
be added to the best position near the caret.

Recording sounds



Select a recording format 
Get a good level 
Overdubbing 
Start recording! 
Save your recording 
You can record sounds from the CD, line-in or microphone of your soundcard.    You 
can do this by pushing the record button on the toolbar or by selecting “Record 
Sound...” from the Sound Group menu.    This brings up the following dialog.

1. Select a recording format.
First select the desired recording format for the new sound.    You can choose 3 
sampling rates (11,025 Hz, 22,050 Hz or 44,100 Hz.)    As the sampling rate gets higher, 
the sound becomes more and more crisp as it is able to record the higher frequencies. 
The only drawback is that higher sampling rates also mean bigger file sizes. 

You can choose either 16 or 8 bit.    16 bit will be cleaner and 8 bit will have a fuzzy 
quality to it, especially when sounds are relatively quiet.    The drawback to 16 bit is 
that it will mean the files will be 2 times larger.

Finally select whether it is a stereo or mono recording.    Again, stereo files are 2 times 
larger than mono files.

2. Get a good level.
Next, it is important to have a good level. Usually, you want your recording level to be 
in the green zone.    This will help guarantee that you get a good signal to noise ratio 
and that your recordings are coming out relatively strong.    (Of course, you may not 
always want to be in the green zone, depending on what you are doing.)

If the level is weak, you may need to adjust your soundcard’s recording levels.    Make 
sure that the CD, line-in or microphone level in the soundcard’s mixer is not muted and 



is at a good level. 

You can usually adjust the mixer levels by double clicking the speaker icon found on 
the lower right hand side of the Windows95 desktop. 

The initial screen will probably say “Volume Control”.    You need select “Properties” 
from the “Options” menu.    You will see some selections.    Click on “Adjust Volume for 
Recording”.    Please consult your soundcard or Windows95 documentation for further 
help.    (Some soundcards implement this differently).

3. Overdub (optional)
New to version 1.2, you can choose to overdub.    Overdubbing will let you record while 
playing back your previously recorded sounds.    Note that playback will start from 
wherever the indicator was last.    To enable overdubbing, select the checkbox called 
“Overdub”.

When the overdub option is selected, the “Use Rec Format” option becomes enabled. 
If checked, this will force the playback format to be the same as the recording format.    
This is a very useful feature because many soundcards require you to record in the 
same format as you are playing sounds in. 

4. Start recording!
Once the recording format has been selected and you have a good level, press the 
Record button. 

5. Save your recording
When finished, hit the “Stop” button.    This will bring up the following Save Recording 
dialog.



This allows you to play the sound to see if it was a good recording.    If you don’t like it, 
hit the cancel button and try recording again. 

The slider allows to quickly fast forward to different parts of the recording without having 
to wait for the whole thing to play.

If you leave the Add sound to session after saving checkbox checked, then the sound 
will be added at the position of the current caret after saving.

When ready to save, hit the    Save button and you’re done!

Editing sounds in an external editor
If you want to apply effects other than volume, pan and rate, you will need to edit it in 
an external editor.    Make sure that you have already setup an external sound editor in 
the Preference dialog.    (Check http://www.acoustica.com for the latest on external 
sound editors.)

Right click on the sound you want to edit and select “Edit in External Editor”.    This 
brings up a dialog with two main choices.

1. You can edit a copy of the sound.    This option is the preferred method of editing a 
sound because if you later decide you don’t like it, you will be able to undo the edit. 
In addition, you can have Internet Audio Mix automatically pick a name for the new 
sound, thereby saving you the trouble.    This will happen if the “Automatically 
choose a new name for the sound” checkbox is checked.    You can also simply 
type in a new filename or browse to find one.

2. You can edit the original sound.  This makes permanent non-undoable changes.    
You might choose this if the sound is extremely large and you can’t afford the disk 
space to make a copy.    The con to this option is that it is not reversible!

Once you have picked an edit option, click the Edit button and it will launch the 
external editor with the sound.    Another dialog box appears which waits for you to 
finish your editing.    Make all the changes you want in the external editor, and save the 
file (in the external editor).    Go back to Internet Audio Mix and hit either Done or 
Cancel, depending on how the edit went.    In the case of editing the original sound, it 
won’t make a difference.    However, if you edited a copy of the sound, Cancel will 
delete the copy from your hard drive.

Playing and stopping sounds
Simply move your mouse over a bar, and the Play button will appear in the upper left 
corner.    Simply press the Play button to hear the sound.    Once the sound is playing, 



you may stop the sound by pressing the Play button again.    When the cursor turns 

into a hand with a play triangle such as , you are able to play or stop the sound.

When a sound is playing, an indicator shows the position in the sound being played at 
that time.

Fig03. Playing a sound.

Positioning and resizing/looping sounds
Once the sound is in Internet Audio Mix, you can move it to different times by clicking 
the sound’s handle and dragging the sound.    The cursor turns into a hand indicating 
that it can be moved.

Fig05. Moving a sound.

Once you release the sound, Internet Audio Mix will determine if the sound needs to be 



on another track, in case of overlapping sounds.    In some cases, you may need to 
scroll down to see the sound’s new position.    (Note that Internet Audio Mix will not 
change the sound’s starting time.)

You may resize a sound by clicking on the right side of sound and then dragging the 
mouse left or right.    By resizing the sound, you are also either shortening the sound or 
making it loop.    This looping feature can be handy for extending sounds such as drum-
loops or repeating sounds like sirens in the distance.

Fig06. Resizing a sound.

Changing the sound’s volume, pan and rate.
Each sound has its own volume, pan and rate settings.    When a sound is initially added 
to Internet Audio Mix, it has a default set up: The volume is at 100%, the pan is 
centered, and the rate is at 100%.    For each parameter, there are 2 pivot points.    By 
clicking on the pivot point, you can adjust the attribute.    You will notice that the mouse 
turns into a cross when you are over a pivot point.

Fig07. Mouse is over a volume pivot point.



You can add as many extra pivot points as needed by clicking on the bar when the 
cursor changes to a pencil . 

Fig08a. Before adding a volume pivot point.

Fig08b. After adding a volume pivot point.

To change the current parameter (volume, pan, or rate), select from the drop down box 
on the right side of the toolbar. 

Fig09. Drop down box to select current effect.

In addition to moving individual points, you may also move the line that connects the 2 
adjacent points.    When the mouse is over the line, it will look like a vertical resize 
cursor.    You can simply press the mouse down and drag, which causes the 2 points to 
adjust their values.

To delete a pivot point, position your mouse over the point and right click.    Select Delete 
Point from the popup menu.

Limits of the pivot points.

· Volumes from 0% to 100%
· Pans from 100% Left Speaker to 100% Right Speaker



· Rates from 10% to 400% original speed.

Sound Information Dialog
Click the right mouse on a sound and select Sound Info from the pop-up menu.    A 
dialog will come up displaying the sound’s name, file location, sound format, length and 
size.    You may change the sound’s name by editing the name text box.

Fig09a.    Sound Information Dialog.

Compressed Sounds 
Any compressed sound files are loaded via Window’s Audio Compression Manager and 
therefore a codec must be installed on your machine.    The Audio Compression 
Manager is standard on Win95/98/NT. 

Generally, any codec should work, but here is a list of tested codecs.

Microsoft IMA ADPMCM, Microsoft ADPCM, Microsoft GSM 6.10, Microsoft CCITT 
G.711 A-Law and u-Law

MP3 support is now built in to Internet Audio Mix.    You no longer need any special 
software.    However, due to royalty and patent costs, it requires a separate registration. 
You still can use it for a 30-day trial before deciding whether or not to purchase it.



Working with Sound Groups

Sound Groups are useful collections of sounds.    By combining sounds into a Sound 
Group, the user has more master control over the way the sounds are mixed together. 
You can think of a Sound Group as a composite sound.    Sound Groups are hierarchical 
and may be many layers deep, much like the file directory system on this computer.

Creating Sound Groups 
Moving a Sound Group 
Adding sounds to a Sound Group 
Collapsing and Expanding Sound Groups 
The Main Sound Group 
Loading Sound Group Files 
Adding Sound Group Files 
Playing, stopping and muting Sound Groups 
Adjusting a Sound Group  ’  s volume and pan.   
Mix To A Single Sound 
Missing sounds 

Creating Sound Groups
Sound Groups are created by choosing NewGroup from the Sound Group menu. When 
the Sound Group is created you have the option of naming it.    The Sound Group’s 
name will default to “Untitled”. 

Note that this same dialog can be invoked by selecting the Sound Group with the 
mouse and selecting Group Info from the Sound Group menu.

If sounds and other Sound Groups are selected, you will be able to Group From 
Selection, which simply creates a new Sound Group and adds all the selected sounds.

Fig10a. Creating a Sound Group from a selection of sounds.



Moving a Sound Group
A Sound Group may be moved in the same way that a sound is moved.    Simply 
position the mouse on the Sound Group’s title bar, click the left mouse button and move 
the mouse.

Note that a Sound Group may not be resized by stretching the right side of the Sound 
Group.    However, a Sound Group may be resized by Expanding a Sound Group and 
moving the sounds within.

Adding sounds to a Sound Group
To add sounds into a Sound Group, simply select the sound or sounds and drag them 
over and into the destination Sound Group.    The sounds that you are changing will look 
more transparent when they are able to go into a Sound Group.

Fig11. Moving a Sound into a Sound Group.

In addition, you can also drag Sound Groups into other Sound Groups.    The Sound 
Group hierarchical system can be very useful for organization and Sound Group re-use.

Collapsing and Expanding Sound Groups
Initially, a Sound Group appears as a bar. 

Fig12.    Initial look of a Sound Group.

If you select the Sound Group, you may Expand it.    Expanding the Sound Group 
causes the main display to be replaced by the contents of the new Sound Group.    You 
can expand a group by selecting Expand from the Sound Group menu.    Expanded 
groups have a red diagonal striped background, which helps you know the extent of the 
Sound Group.



Fig13.    Expanded Sound Group

Once you have Expanded a Sound Group, you may also Collapse it, which simply 
replaces the screen contents with the parent Sound Group.      Collapse can be found on 
the Sound Group menu as well, as long as the user is viewing an expanded Sound 
Group.

The Main Sound Group
The Main or first Sound Group is special.    Although it doesn’t appear as a bar, it is the 
main container for all sounds and sub Sound Groups.    When Internet Audio Mix loads, 
you start in the main Sound Group.    You cannot collapse the Main Sound Group. 

When the user selects Save from the File menu, they are actually saving the main 
Sound Group.    (See File : Save )

Loading Sound Groups 
Previously saved Main Sound Groups may be reloaded by selecting Open from the File 
menu, which brings up a standard file dialog.    Find the Sound Group file (.sgp) and 
select the “Open” button. 

Adding Sound Group Files
You may also add Sound Group files to Internet Audio Mix in the same way that you 
drag Wave sounds from the desktop.    Locate the Sound Group file(s) on the desktop 
and drag them into Internet Audio Mix.    The Sound Group and all sub sounds and sub 
Sound Groups will be automatically added!

Playing, stopping and muting a Sound Group.
Sound Groups may be played in the same way that sounds are played.



See Also. 

The Main Sound Group may be played by selecting Play from the Sound Group menu 
or by pressing the Play button on the toolbar.

You may play a selection of the current group by first making a selection and the 
pressing the Play button.

Adjusting a Sound Group’s volume and pan.
Sound Group’s may be adjusted in the same way that sounds are adjusted.    Note that 
the Sound Group’s parameters affect all sub Sound Groups and sounds contained 
within.    (Note that playback rate is not an option for Sound Groups.)

Example
SoundWarrior has about 100 burps that make up this splendid audio delicacy.    He 
wants to make it sound like they are far away and to the left.    Instead of changing the 
volume and pan for every single burp, like he did last time, he decides to create a new 
Sound Group with the burps, called “Burp Group”.    Then he simply lowers the volume 
and pans “Burp Group” to the left, and walla. 

Mix To A Single Sound
If the layers of sounds are too thick or maybe you computer’s performance is slowing 
down, you have the option of mixing a Sound Group down to a single Wave file.    Just 
right click on a Sound Group and select “Mix To A Single Sound”.    A dialog will pop 
allowing you to select the destination sound format.    Preview how it will sound and 
when you’re ready press the “Save” button.    Pick a new filename and it will convert the 
Sound Group into a single sound.    You can always undo this back to a Sound Group.    
The only item to note is that the sound that was created will remain on the hard drive.

Missing Sounds
Sometimes when loading a new Sound Group, Internet Audio Mix may not be able to 
find a sound.    The sound may have been moved to a different hard drive or folder.    Or 
you may have changed its name.    In that case, a dialog pops up and automatically 
searches for the sound.    If you know where the sound is you may select the Browse 
button to explicitly tell Internet Audio Mix to use a certain sound.    If you don’t care 
about the sound, you may simply hit the Skip button.

Fig13a.    Internet Audio Mix is searching for a missing sound.





Main Window

The main window represents the primary Sound Group. 

The Session 
Timeline & Playback Indicator 
The Caret (Pasting point) 
Zoom In & Out 
Scrolling 
Copy, Cut & Paste 
Undo & Redo 
Selecting Sounds and Sound Groups 
Toolbar 

The Session
The session is simply a convenient terminology to describe all sounds and Sound 
Groups currently loaded in Internet Audio Mix.

Timeline & Playback Indicator
The timeline simply shows the current time relative to the sound(s) and Sound Group(s).

Clicking the timeline with the left mouse button will position the playback indicator.    
While the Main Sound Group is playing, this will also cause playback to occur from this 
time offset. 

If the “Set playback indicator when clicking session” option is checked from the 
“Miscellaneous” tab of the preference dialog, then clicking inside the session will also 
set the playback indicator.

Fig15.    The Timeline.

The Caret
Caret is one of those weird computer terminologys that usually confuses everyone.    
The caret is simply the point where pasting will occur.    Click the left mouse button in the 
main window to position the caret.    (You must click in an empty spot; meaning there 
aren’t any sounds or Sound Groups under the mouse.) 



Fig16. The “Caret”.

Zoom In & Out
Internet Audio Mix allows you to zoom in up to a resolution of 1 pixel = 4 millisecond.    
Internet Audio Mix allows you to zoom out to a resolution of 1 pixel = 2 minutes, which 
should cover the needs for most users of Internet Audio Mix.    Note that only 
horizontal/time zoom is supported.    (There is no vertical zoom.)

Scrolling
If the main window does not show all the sounds and Sound Groups, Internet Audio Mix 
will display scroll bars so that you may scroll to the unseen parts. 

Copy, Cut & Paste
The standard Window’s copy, cut & paste is supported by Internet Audio Mix. 

To copy, simply select a sound(s) and/or Sound Group(s).    Then select Copy from the 
Edit menu. 

To paste, after copying some sound or sounds, position the <caret> at the desired paste 
point, and select Paste from the Edit menu.    Copies of the buffered sound or sounds 
will appear in the window.

To cut, simply select a sound(s) and/or Sound Group(s). Then select Cut from the Edit 
menu.    The sound or sounds will be removed from the window.

Undo & Redo
If you made a mistake or you didn’t like the way something sounded, simply select 

Undo from the Edit menu and you will be restored to the previous state. 

Likewise, if you decide that you actually like the way it was before, select Redo from the 
Edit menu and you will be restored back to the previous state.

· Note that after saving a Sound Group, the undo memory will be cleared and you will 
not be able to undo to previous states.

· Undo and Redo are supported for moving, resizing, grouping sounds and Sound 
Groups, and adding and deleting pivot points.

Selecting Sounds & Sound Groups
You may select a sound by simply clicking the left mouse button over it.    Or you may 



select multiple sounds and/or Sound Groups by holding the left mouse down in an 
empty spot and moving the mouse over the desired sounds and groups. 

Fig17.    Selecting multiple sounds.

You can also hold the Control key (Ctrl) down and toggle individual sounds and Sound 
Groups selected status.



Exporting to RealAudio™

What is RealAudio™ ? 
Exporting to RealAudio™ 
Creating the RealAudio File (.ra) 
Optimizing your sound for RealAudio™. 
Uploading it to the Internet. 

What is RealAudio™ ?
RealAudio is an audio format, which is highly compressed and small, allowing for real 
time streaming of audio over the Internet.    RealAudio is a proprietary technology owned 
by RealNetworks, Inc.    The latest version of RealAudio is called G2.    Its main feature 
is called SureStream, which allows for multi-rate RealAudio files.

Exporting to RealAudio™.
One of the convenient features of Internet Audio Mix is the ability to instantly render the 
session into a RealAudio file. Simply select Save As.. from the File menu and change 
the file type to RealAudio™.      Select a filename and select the Save button.    This 
brings up the following dialog… There are several factors to consider.

SureStream vs. Single Rate 
Target Audience 
Content Type 
Render All or Selection 
Clip Information 



Fig17a.    Exporting to the Internet.

q SureStream vs. Single Rate
SureStream is RealNetwork’s multi-format file.    It’s the most important 
feature of G2.    You can create a SureStream file that will work with people 
connecting through a LAN, in addition to people with bit-pushin’ 28.8 
modems!      The people with the higher speed connection will be served 
higher quality audio, while the people with the lower speed connection will be 
served the “less than perfect” audio.    You can have up to six target 
audiences.

What’s the catch?    You need a RealServer G2 for playback!      (Your ISP may 
have a RealServerG2 already setup.)

· Pressing ‘Preview’    will automatically render the first 5 seconds of the 
session with the selected codec .

· Pressing ‘Fine Tune ’ will bring another dialog, which allows you to 
fine-tune the selected codec in case the preset codecs don’t sound 
good.

· Selecting the “Create RealPlayer 5 Compatible Clip” will allow the 
older RealPlayer 5.0 players to play the clip.    It will make the clip 
slightly larger.

Single rate files can also be created.    These files can also be streamed via a 
traditional web server, just as if you were downloading a file. 

· Pressing ‘Preview’    will automatically render the first 5 seconds of the 
session of the current codec.

· Pressing Fine Tune will bring another dialog, which allows you to fine-
tune the current codec in case the preset codecs doesn’t sound good.

q Target Audience
Who is the target audience?    Perhaps, you have a lot of corporate visitors 
with LANs, but you also have 56K modem users.    You might select 2 target 
audiences (56K Modem & Corporate LAN). 

You can select up to 6 different target audiences if you are creating a 
SureStream.    If you are creating a single rate file, you can only select one 
target audience at a time.

q Content Type
This one is pretty self-explanatory.    Is your masterpiece music or voice?    Or 
is it voice with background music?    If the stereo separation is an important 
part of the piece, you might select “Stereo Music”.    The most important test 
is to simply listen to how it sounds in the various settings.    The preview 



feature makes it very easy to do this.    Take advantage of it.

If you are going to eventually include this with a RealSlideshow™ or a 
RealVideo™, you should uncheck the “Audio Only?” checkbox which will 
adjust any selected codecs.    (It will lower the bit-rates to accommodate other 
data being downloaded.)

q Render All or Selection
One of the cool features of Internet Audio Mix is that you can render 
selections anywhere in your session.    Select some sounds and press the 
RealAudio button.      Now you can press the “Render Selection” radio button, 
which will enable you to render the current selection!    This can be very handy 
if you are curious how a particular segment sounds, but you don’t want to 
render the entire 1 hour piece!

q Clip Information
This is the information that is stored with the clip.    The name of the clip will 
default to the name of the main Sound Group.    The copyright and author 
information will default from the Miscellaneous information tab in the 
Preference dialog.

Fig17b.    RealAudio Fine Tune Dialog

If you choose to fine-tune a codec, it will bring up this dialog (fig17b).    You may choose 
a different codec and preview it.    The bit-rate, frequency response, compatibility 
information and a detailed description are displayed as you switch between different 
codecs.    It will not allow you to exceed the maximum bit-rate for the target audience 
you are tuning.



Note: It may take awhile for the RealAudio file to be completely rendered, depending on 
the power of your computer and the length of the session.    You may hit the cancel 
button to escape a lengthy encoding.

Creating the RealAudio File (.ra)
After you are happy with the settings, you should press the Save button on the main 
RealAudio dialog.    Pick a filename and press “Save”.    It may take awhile for the 
RealAudio file to be completely rendered, depending on the power of your computer 
and the length of the session.    You may hit the cancel button to escape a lengthy 
encoding.    By default, after it is finished encoding, it will play the newly rendered file.

Optimizing your sound for RealAudio™
You may be wondering, “how can I improve the way that my RealAudio files sound?”    
The rule of thumb is to not make your Sound Groups too quiet. If you feel they are too 
loud, simply turn your speakers down.    You will notice substantial improvements if the 
volume levels are kept as high as possible. 

If you have an external editor that can “compress” the sound, this may also help for 
RealAudio conversion.    This is not the file type compression.    This is referring to 
dynamic amplitude compression.    Basically it takes the low parts of your sound and 
makes them louder, as well as taking the loud parts and making them quieter.

Uploading it to the Internet.
Internet Audio Mix does not upload or publish the file to the Internet by itself.    You will 
find that most WEB page creation programs have this type of feature built in.    You 
may also choose to use a F.T.P. program to upload the RealAudio file. 

Check the “Links” page on Acoustica for some links to sites that have useful 
information on uploading RealAudio files!



Preference Dialog

Playback Tab 
Recording Tab 
Miscellaneous Tab 
Information Tab 

Playback Tab
The Playback tab allows you to choose the quality at which your session plays. 

New in version 1.2!    If you have more than one soundcard, you can choose the 
soundcard you want for playback in the Playback device drop down at the top of 
window.

If you select Use Best Quality, Internet Audio Mix will always use the best sound format 
in the session as the default sound format.    Choosing this option will ensure that you 
don’t have any sound degradation. 

You may, instead, choose to use a specific format.    Wave formats have the following 
characteristics:

· Sample Rate
Sample rate simply means the number of times per second that the computer 
plays or records a snapshot of the sound.    Faster sample rates catch faster 
frequencies.    You may set the format to the following sample rates : 11,025 , 
22050, and 44,100.

· Bits Per Sample
This determines the quality of each snapshot.    The more bits, the better.    You 
may set the format to either 8 or 16.    (8 has a tendency to sound fuzzy)

· Number of channels
Is it stereo or mono?    Setting the format to mono, will essentially disable 
panning.

The advanced section allows you to change the number of buffers and buffer size.    
Without getting too complicated, you use these options to find a balance between audio 
discontinuity and playback latency.

Latency is the amount of time it takes from the time you press the Play to the time you 
hear the sound.    If you feel the latency is to big, try reducing the number of buffers or 
the buffer size.

Audio discontinuity is sometimes described as “popping” or “static”.    The audio will 
drop in and out.    If you have audio discontinuity problems, try increasing the number of 
buffers and/or the buffer size.



Recording Tab
Choose a Recording Device from the dropdown box if you have more than one 
soundcard!

This tab also has a full duplex test.    It lets you know if your soundcard supports full 
duplex, which is the ability to play sound and record at the same time.    Press the “Test” 
button to see how your soundcard fares.

The advanced tab is similar to the advanced tab for playback.    Here, you get to select 
the number of buffers and the buffer size set-aside for recording.    If you find that your 
recordings are missing sound or have static glitches, try increasing the number of 
buffers and/or the buffer size. 

You may also select the temporary recording directory.    Simply type in the path to the 
directory.    For example, say you have 5 GB of space on drive E:.    Simply, type “E:\” 
and press the “OK” button.    If you want to record using your computer’s RAM, clear all 
characters from the edit box so that it is empty.    You should see “(RAM)” displayed 
above and then hit “OK”.

Miscellaneous Tab

q Auto scroll during playback.
Normally, during playback if the indicator gets near the right end of the 
window, the view is scrolled over in time.    This option allows you to turn that 
off or back on.

q Start playback at beginning when near end.
Normally, if the session has played to the end, starting playback again will 
also cause the session to rewind to the beginning.    This option allows you to 
toggle the behavior.

q Wave Display Resolution
Internet Audio Mix can operate faster because it doesn’t load in a pixel for 
every sound sample.    It defaults to 20 milliseconds per pixel.    You can now 
configure it to be anywhere from 1 millisecond per pixel to 100 milliseconds 
per pixel.

q Don  ’  t load waveforms for sounds larger than X seconds  
If you’re mixing .mp3s or just large waveforms, it can take awhile to get the 
waveform.    Therefore, this option will cause IMIX to skip loading waveforms 
for the sounds larger than the value you put into the text box.

q Setting the playback indicator when clicking in the session window.
If you click within the main window, this will cause the playback indicator to be 



set.    Normally, this only sets the caret (paste point).    If you are currently 
playing, it will restart playback from this position.

q Play RealAudio files after rendering them.
After rendering a new file, you don’t want to have to go find it on your hard 
drive; you just want to hear it.    This convenient feature makes

q Editing sounds in an external editor.
If you want to edit sounds in an external editor, you need to select an external 
editor executable that Internet Audio Mix launches.    You can either type in 
the full path to the sound editor or press the Browse button to find it through 
Window’s file system.

Information Tab
The name, and copyright fields will automatically appear when rendering the session to 
a RealAudio™ or Wave file.    This saves you the trouble of having to type it every time 
you want to render a file.



File Menu

New 
Open 
Add Sound 
Save 
Save As.. 
Preferences 
Exit 

New
This menu item clears the Main Sound Group.    If the current Main Sound Group is dirty, 
it will first ask if you want to save, before clearing.

Open
This menu item brings up a standard file dialog, which allows you to find a Sound Group 
file (.sgp) to load as the Main Sound Group.    If the current Main Sound Group is dirty, it 
will first ask if you want to save, before loading. 

Add Sound
This option allows you to add Wave files or Sound Groups to the current Sound Group.

Save
This menu item saves the Main Sound Group as a Sound Group file (.sgp ).    If the Main 
Sound Group has not been saved yet, it will bring up a standard file dialog allowing the 
user to pick a filename and folder.

Save As…
This menu item allows the user to save the Main Sound Group with a different name. 

Currently, you may save it as one the following…

Sound Group 
Wave File
RealAudio™ File. 

You may elect to use this option if you are branching off in several possible sound 
designs and want to be able to compare them. 

Exit
There’s always a time when you have to turn it off.    You can’t use Internet Audio Mix all 
the time.    (We don’t mind that much, though. ;-) ) 

This exits Internet Audio Mix.    It will ask if you want to save, if the Main Group needs to 
be saved.





Edit Menu
Undo 
Redo 
Copy 
Cut 
Paste 
Select All 
Zoom In 
Zoom Out 

Undo
Undo allows you to go back to previous states.    Undo is supported for the following 

actions.

q Adding a sound or sounds to Internet Audio Mix.
q Cutting a sound or sounds.
q Moving a sound or sounds.
q Resizing a sound.
q Adding a volume, pan or rate pivot point.
q Changing a volume, pan or rate pivot point.
q Deleting a volume, pan or rate pivot point.

Once you save, the Undo memory is cleared. (Thus, you cannot Undo after saving…)

Redo
Redo is the opposite or Undo.    For example, Sound Warrior adds a pivot point on his 
“heartywarcry.wav”, then decides he doesn’t like it and does an Undo.    Suddenly, he 
thinks of the ancestors looking down upon him and decides to put it back by doing a 
Redo.

Copy
Copy will take a snapshot of all currently selected sounds and Sound Groups.    Each 
successive Copy command clears the previous copied sounds and Sound Groups.      
Note that this will copy only the selected portions of sounds and Sound Groups.

Cut
Cut will remove all currently selected portions of sounds and Sound Groups from 
Internet Audio Mix.    It will also copy the selected portions of sounds into the clipboard 
for pasting.    (Don’t worry, remember, you can Undo.)

An alternative to Cut, is the ‘Delete’ key.    This will cut all the selected portions of 
sounds, but will not store them in the clipboard.    This is handy if you don’t want to 
overwrite the contents of the clipboard. (This was a registered users requested feature)



Paste
Paste will add all Copied sounds and Sound Groups to Internet Audio Mix at the Caret 
position.

Select All
All sounds and Sound Groups in the current Sound Group will be selected.

Zoom In
Internet Audio Mix allows you to zoom in up to a resolution of 1 pixel = 4 millisecond.

Zoom Out
Internet Audio Mix allows you to zoom in up to a resolution of 1 pixel = 2 minutes.





Sound Group Menu
In addition to the menu bar, you can right click in the main session to get this menu.

Add Sound… 
Record Sound… 
New Group/Group From Selection 
Send To Parent Group 
Group Info 
Collapse 
Expand 
Play/Stop 
Rewind 
Fast Forward 

Add Sound…
This option brings up a standard file dialog allowing you to select a new Wave file (.wav) 
to include in the current Sound Group.    It will appear at the current position of the 
Caret.

New Group/Group From Selection
If sounds and/or Sound Groups are selected, the “Group From Selection” menu option 
will be active.    This will create a new Sound Group and then add all the sounds and/or 
Sound Groups currently selected.    The New Group option will appear if there isn’t 
anything selected.    Both New Group and Group From Selection will then bring up the 
Group Info dialog allowing you to give it a good name, instead of “Untitled-X”.

Send To Parent Group
This sends the currently selected sound or Sound Group to the parent Sound Group.

Group Info
Group Info is a dialog that allows you to change the name and associated comments.    
It also displays the date the Sound Group was created, its length in time, the number of 
sub-sounds and sub-Sound Groups.

Collapse
Collapse allows you view the parent Sound Group as the active Sound Group.    It 
“collapses” the currently “expanded” Sound Group.

Expand
Expanding a Sound Group causes it to become the active Sound Group.    You will see 
its sub-sounds and sub-Sound Groups in the main window.

Play/Stop
This option plays or stops the Main Sound Group.



Rewind
This causes playback to rewind to the beginning of the Main Sound Group.    This can 
happen during playback.

Fast Forward
This causes playback to fast forward to the end of the Main Sound Group.    You may 
use this option to get to the end of the Main Sound Group quickly.





Sound Bar Menu
Important!    The sound bar menu is a context sensitive menu, meaning that it only 
appears if you right click on a sound bar.    Make sure that the sound is selected first.

Cut 
Copy 
Invert Map 
Reset Map 
Sound Info 
Send to Parent Group 
Muted 
Play/Stop 
Locked 
Edit In External Sound Editor 

Cut

This will remove the sound from the main window.    (You can always redo to get it 
back.)

Copy

This will copy the sound and it’s associated pivot points for volume, pan and rate into 
memory.

Invert Map

This is a helpful function, which changes each pivot point to an opposite or mirrored 
value.    (This can be undone, as well.)

q Volumes of 100% will go to 0%.    Volumes of 50% will stay the same.    Volumes 
at 33% will go to 66%, etc.

q Pans of 100% left will go to 100% right.    Pans of 0% will stay the same.    Pans 
of 30% will go to 70%, etc.

q Rates of 50% will go to 200%.    Rates of 100% will stay the same, etc.

Reset Map

Have you added a billion pivot points to “godly.wav”?    Don’t want to undo everything 
else that you like, but you want to get this sound back to normal.    Simply select this 
Reset Map and it will be set back to the very original settings.    This works for each 
effect type separately, so you don’t have to cleanse the volume, if you’ve been mucking 



around with the rate. 

For volume, you will return to a sound or Sound Group with 2 pivot points, one at the 
start and, one at the end.    Both will be at 100% volume.

For pan , you will return to a sound or Sound Group with 2 pivot points, one at the start 
and, one at the end.    Both will be at 0% Pan (Centered between the speakers).

Sound Info

This brings up a dialog with information about the sound.

Send to Parent Group

This sends the selected sound to the parent group.    The sound will maintain its current 
time offset.

Muted

This either sets the sound to be muted or un-mutes the sound.    A check mark on the 
menu item indicates that it is muted.

Locked

This is a flag tells you if the sound is locked in position.    If it has a check box next to it, 
it means that the sound bar is locked and cannot be moved.    To reposition a locked 
sound, un-toggle this option.

Play/Stop

This will play the sound if its not playing and stop it when it is. 





Toolbar

The toolbar allows quick access to common functions.

      Create a new Main Sound Group.

      Open/Load a Main Sound Group.

      Save the Main Sound Group.

          Add a sound to the Main Sound Group

      Play/Stop the Main Sound Group.

      Rewind to the beginning of the Main Sound Group.

      Fast Forward to the end of the Main Sound Group.

          Record a new sound from the CD, line-in or microphone.

      Zoom In.

      Zoom Out.

      Collapse the current Sound Group.

      Expand the selected Sound Group.

          Previews the sound as RealAudio®.

      Allows you to change the current effect displayed on the Sounds and 
Sound Groups.







Pan

The relative balance between the left and right speaker.



website

http://www.acoustica.com



(.mp3)

Mixing .mp3 files is available as an extra registration fee due to royalty costs.    MP3 is a very popular near CD-quality format.    It 
is about 1/12th the size of a normal CD-quality recording.



Sound Group

The project file for Internet Audio Mix. (.sgp)



Codec

Codec stands for coder – decoder.    In our case, codecs refer to small audio program-ettes, which convert compressed audio to 
uncompressed audio and vice versa.




